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Manual VIPA HMI About this Manual

About this Manual

This manual describes the structure, project engineering and the handling
of the Text Display TD 03 from VIPA.

Overview Chapter 1: Hardware description

In this chapter the hardware components of the TD 03 are described.
Besides of a description of the single components, the dimensions that are
required for the installation may also be found. The chapter closes with the
technical data.

Please consider the safety hints at the beginning of the chapter.

Chapter 2: Deployment of the TD 03

This chapter explains the deployment and the project engineering of the
text display TD 03.

After the fast introduction there are information about the installation and
the configuration by the TD Wizard. This is followed by the description of
commissioning and operation of the TD 03.

The chapter closes with a description of the firmware update.

Chapter 3: Installation guidelines

The chapter gives you information about the interference-free installation of
Programmable Logic Controls (PLC) together with a TD 03.

Here we describe possible paths how interference can enter the controller,
how you ensure the electromagnetic compatibility (EMC) and how to
approach shielding and screening issues.

HB116E - TD 03 - Rev. 15/04 1
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Objective and

This manual describes the Text Display from VIPA. The manual consists of

contents chapters. Every chapter provides the description of one specific topic.
It describes the installation, project engineering, usage and the technical
data.
This manual is relevant for:
Product Order number ab Stand:
HW FW
TD 03 VIPA 603-1TD03 03 1.05
Guide to the This manual provides the following guides:
document « An overall table of contents at the beginning of the manual
» An overview of the topics for every chapter
Availability The manual is available in:
» printed form, on paper
* in electronic form as PDF-file (Adobe Acrobat Reader)
Description [Button] Buttons are put in brackets e.g. [NEXT] or [OK].
conventions [Key] Key entry are put in brackets e.g. [STRG]+[A].
Di spl ay Display outputs are illustrated as Courier e.g.
out put \ fl ashdi sk>
Keyboard Keyboard entries are illustrated as Couri er bol d e.g.
entry \flashdisk> Dir
Terms Menus, Display elements, terms are italics.
Icons Important passages in the text are highlighted by following icons and
Headings headings:
Danger!
Immediate or likely danger.
Personal injury is possible.
Attention!
Damages to property is likely if these warnings are not heeded.
Note!
Supplementary information and useful tips.
2 HB116E - TD 03 - Rev. 15/04




Manual VIPA HMI

Safety information

Safety information

Applications The Text Displays are constructed and manufactured for:

conforming with .
specifications

VIPA CPUs 11x, 21x, 31x, 51x and S7-300/400 from Siemens
communication and process control

general control and automation applications

industrial applications

operation within the environmental conditions specified in the technical
data

installation into a cubicle

Danger!
This device is not certified for applications in

in explosive environments (EX-zone)

Documentation The manual must be available to all personnel in the

project design department
installation department
commissioning

operation

The following conditions must be met before using or commissioning
the components described in this manual:

Modification to the process control system should only be carried out
when the system has been disconnected from power!

Installation and modifications only by properly trained personnel

The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal National rules and regulations apply to the disposal of the unit!

HB116E - TD 03 - Rev. 15/04 3
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Chapter 1 Hardware description

Chapter 1

Overview

Content

Hardware description

In this chapter the hardware components of the TD 03 are described.
Besides of a description of the single components, the dimensions that are
required for the installation may also be found. The chapter closes with the
technical data.

Please consider the safety hints at the beginning of the chapter.

Topic Page
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Safety information for Users

Handling of
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOS-
technology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by
electrostatic discharges:

The symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.

It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable.

Modules that have been damaged by electrostatic discharges may fail after
a temperature change, mechanical shock or changes in the electrical load.

Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Attention!

* If your panel is to be supplied externally, you have to make sure that the
communication cable does not have any power allocation. Otherwise the
connected devices could be damaged.

» Before commissioning, the device has to be brought in environment
temperature.

» With condensation you may only switch on the device after complete
dryness.

» To prevent overheat during operation avoid direct sun contact of the
device.

» After opening of the control cabinet or panel, parts of the system are
available that may lead dangerous voltage.

» All signal connections require screened cables.

» Signal cores may not be lead within a cable shaft of high-voltage cores.

» Please take care for sufficient ground of the operating device. For this a
ground screw is to be found at the backside of the device.

1-2
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Shipping of Modules have to be shipped in the original packing material.
electrostatic
sensitive modules

Measurements When you are conducting measurements on electrostatic sensitive
and alterations on  modules you should take the following precautions:
electrostatic + Floating instruments must be discharged before use.

sensitive modules Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

HB116E - TD 03 - Rev. 15/04 1-3
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Properties
General The here shown operating device allows you to visualize and alter
operating states and recent process values of a connected PLC. For the
entry of values and navigation, the operating device is provided with an
integrated keyboard and a 2x20 character display. The link-up to your PLC
happens via MPI.
The project engineering happens in the projecting tool TD Wizard from
VIPA. TD Wizard creates a data block containing your presetting that may
be accessed by the CPU at need after the connection of the TD 03.
VIPA  Text Display TD 03
F1  F2 F3  F4 ' '
TD 03 * Die-cast aluminum case
603-1TDO0 » Protection type: front side IP65, back side IP20
» Display with 2 x 20 characters
* Project engineering via TD-Wizard from VIPA
« MP?| interface for CPU link-up and firmware update
 Visualization of the connected CPU via MPI
* Menus and input requests in German and English language
* Read and alter process values
* Monitoring of messages
» Easy installation via non-losable rocker arms
Order data
Type Order number Description
TD 03 VIPA 603-1TD0O0 | 2x20 characters, MP?l, language: DE, EN
MPI cable VIPA 670-0KB0O0 | OP/AG cable 0°/90° with PU-/Diagnostic port, 2.5m
1-4 HB116E - TD 03 - Rev. 15/04
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Structure
Front view At the front side of the text display TD 03 is the foil keyboard and the
display with 2x20 characters.
UVIPA  TextDisplay TD 03 [1] Display
A ESC | [2] Function keys
[3] Navigation keys
1A/ :
2 | F2 ] F3 | e .
Back view At the TD 03 the connectors are located at the backside.
UIPE [1] MP?linterface
2] Ground screw
[3] Additional slot for DC 24V Power
supply
O
—
o%IM
1 gg P’
ool ! G
2 5 @
+O [ ]|+
3 XL o [l X
Dc24v VIPA 603-1TD00

Attention!

The simultaneous usage of external power supply and the delivered MPI
cable 670-0KBO0O0 is not allowed and damages the TD 03 and the CPU!

HB116E - TD 03 - Rev. 15/04 1-5
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Components

LC-Display

Keyboard

MP?|

Additional

Power supply

The TD 03 monitors values and messages via a STN text display with LED
back lighting. It displays 2 rows with max. 20 characters with a line height
of 5Smm.

At the front side is a foil keyboard with 9 short click keys. 5 keys are
serving the navigation and 4 keys are function keys.

Pushing a function key, a bit is set in a bit memory byte of your CPU. By
requesting the bit memory byte during your PLC application you may react
to the entry.

The TD 03 is provided with a MP?l (Multi-Point-Interface) for connection to
your CPU via a MPI network.

The MP?l jack has the following pin assignment:

9pin jack

Pin Assignment
reserved (must not be occupied)
M24V

RxD/TxD-P (Line B)
RTS

M5V

P5V

P24v

RxD/TxD-N (Line A)
n.c.

o

© 00O NO O WD

Only if you use a MPI cable without power allocation instead of the
delivered MPI cable 670-0KB0O, the TD 03 may externally be supplied with
DC 24V (20.4 ... 28.8V) using this addition power supply slot. The power

+O L) supply is protected against inverse polarity and over-current.

MO [ JIM The simultaneous usage of external power supply and the delivered
DC24V MPI cable 670-O0KBO0O is not allowed and damages the TD 03!
1-6 HB116E - TD 03 - Rev. 15/04



Manual VIPA HMI

Chapter 1 Hardware description

Dimensions

Installation
dimensions

Top view

Back view

For the installation of the TD 03, an installation cutting with the dimensions
156mm x 78mm is required.

Installation values for control cabinets and desks:

Front panel width: 2.5..6mm
Installation cutting (W x H): 156mm x 78mm
Installation depth plus cabling 34mm
e T
0 0
S ) 5
DOJOoOmrrmiMmiIbOO.m@CoO.| oM. - da

VIP& %

90
77
GLEER

X1 DC24'
L+ |1*O [
w0 i

VIPA 603-1TD00 J

154
187

HB116E - TD 03 - Rev. 15/04 1-7



Chapter 1 Hardware description

Manual VIPA HMI

Technical data

Order no. 603-1TD00

Type TD 03, Text Display
Display

Number of rows 2

Characters per row 20

Character height 5 mm

Type of display

STN with LED backlighting

OP functionality

User memory

Number of variables

Language DE/EN
Operating controls
Touchscreen -
Keyboard Membran keyboard
Mouse -
Number of system keys 5
Number of soft keys 4
Technical data power supply
Power supply (rated value) DC 24V
Power supply (permitted range) DC 20.4...28.8V
Reverse polarity protection v
Current consumption (no-load operation) 80 mA
Current consumption (rated value) 500 mA
Inrush current 16 A
12t 0.11 A%s
Time
Real-time clock -
Clock buffered period (min.) -
Accuracy (max. deviation per day) -
Functionality Sub-D interfaces
Type MP2|
Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated -
MPI v
v

MP2l (MPI/RS232)

Point-to-point interface

Mechanical data

Housing / Protection type

Material

die-cast aluminum

Mounting

via integrated pivoted lever

Protect type front side

IP 65

Protect type back side IP 20
Dimensions

Front panel 187 x 90 x 6 mm
Rear panel 154 x 77 x 44 mm
Installation cut-out

Width 156 mm

Height 78 mm
Minimum 2.5 mm
Maximum front panel thickness 6 mm

Weight 610 g
Environmental conditions

Operating temperature 0°Cto60°C

Storage temperature

-20°Cto 70 °C

Certifications

UL508 certification

yes

HB116E - TD 03 - Rev. 15/04
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Teil 2 Deployment TD 03

Chapter 2

Overview

Content

Deployment TD 03

This chapter explains the deployment and the project engineering of the
text display TD 03.

After the fast introduction there are information about the installation and
the configuration by the TD Wizard. This is followed by the description of
commissioning and operation of the TD 03.

The chapter closes with a description of the firmware update.

Topic Page
Chapter 2 Deployment TD 03........ouuiiiiiiiiiiiiiiieiieneiiiieienieeeeeneeeeneneenns 2-1
Fast INtrOAUCTION......coeeeeeeee e 2-2
INSTAIALION ... 2-4
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Fast introduction

Installation

Configuration

Deployment
TD Wizard

Transfer STL into
the project

Build the CPU system and install the TD 03. For the installation in
operating tables and control cabinet fronts a front panel cutting of
156mmx78mm (LxW) is needed.

From the software side the connection to the CPU system happens by a
data block. This may be produced by the configuration tool TD Wizard from
VIPA.

Start the TD-Wizard via double click on HESEEREEERE].

Type a file name for the DB into "Destination File". It is stored as STL
file. Enter the data block number into "Data Block ID". Click on
Mext |

Set the language and character set. Click on — C Nexts |

If wanted, activate further menu options and the password protection.
Click on | Mext> |

Set the bit memory byte that is accessible for the function keys and the
telegram polling rate. Click on _ Mext >

Enter the standard size and the number of your messages. Click on

Mext » |

In the appearing dialog window you can choose the areas where your
data is stored in the DB. Here normally no changes are necessary. Click
on Mext » |

Now you reach the input window for your messages. Enter the
according message texts. If you want to include process data, click on

Embedded data. | | the now following dialog window you can enter the

in the DB. Confirm with i
window.

To enter more message texts, click on _ Ne#message> |

Click on __Finish | 1o store the project at the preset path as STL file
and close TD-Wizard.

Start the Siemens SIMATIC manager with your project.

Select the folder "Sources" in the user program and select Insert >
External Source.

Navigate to the STL file and compile this with Edit > Compile. The
corresponding DB may now be found in the folder "Blocks".

2-2
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Teil 2 Deployment TD 03

Commissioning

Set communication
parameters

Switch on the power supply of your CPU.

Transfer your project including the DB to your CPU. More about the
transfer methods may be found in the manual of your CPU.

Connect the CPU und the TD 03 by the delivered cable 670-0KB00. As
soon as the TD 03 is connected to the CPU, it is automatically started up.

TD 03
E CPU
VIPA 1o Dsmay o0 m ‘ TD-Wizard
I =
RIBIEE]E
MP2| MP2|
MPI (

For communication with the CPU the following parameters are necessary,
which may be set at the TD 03 by the Menu mode with Ter mi nal Set up:

* MPI address of the TD 03

* MPI address of the CPU

» DB no. of the CPU

« Baud rate of the MPI net

» Highest station address in the MPI net

In the following the steps of the fast introduction are more near described.

HB116D - TD 03 - Rev. 15/04 2-3
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Installation

Overview

Installation cutting

Installation

The TD 03 is suitable for the installation in operating tables and control
cabinet fronts. The installation happens via the back side. The TD 03 is
provided with a patented integrated fixing technique that allows an easy
connection with a simple screwdriver.

Note!

Please also consider at installation the "General installation guidelines" in
this manual.

For the installation in operating tables and control cabinet fronts, you need
the following front panel cutting:

< 156mm

78mm —>

P —

The fixing technique is integrated in the casing of the TD 03 and accessible
via the back side.

For the installation, a small slit screwdriver is required. Push the operator
panel [3] from the front side into the front panel cutting [1] until it touches
the panel with the seal [2]. Now bolt the lever [5] clockwise with the
screwdriver [4] until it rotates to the outside. Further screwing bolts the
lever to the front panel until it holds the TD 03 to the control cabinet front.

4~

D >

5 |
1 7 -
j O ]
27 3

2-4
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Project engineering - Overview

Overview The text display TD 03 is projected with the TD-Wizard. This creates a data
block that is accessed from the CPU after the TD 03 has been logged in.
The data block contains all information required from the CPU like e.g. data
areas and message texts that are necessary for the operation of the TD 03.

Transfer the DB e.g. by means of the VIPA Green Cable into the CPU.
More may be found at "Project transfer" at the CPU manual.

During operation, your operating device communicates with the concerning
control and responds to the application processing of the PLC according to
the engineered presetting. With concerning project engineering, you may
monitor res. alter process values via the display and transfer them to the
CPU.

Project engineering

TD 03
1 CPU
[IPA  rowosonr e m TD Wizard
] v
e O /—
MPI MP2|
<~ DB |
Operation Green Cable
TD 03
7 CPU
VIPA  tenommar BT m ‘ TD Wizard
i /—
MPI MP2|
MPI
Not permitted!
TD 03
7 CPU
UIPA renosney oo m TD Wizard
nicicic"
<—— DB programming
MPI \ Green Cable
Attention!

Please consider the simultaneous usage of the Green Cable from VIPA
and the delivered MPI cable 670-O0KB0O is not allowed and damages the
TD 03 and CPU!

HB116D - TD 03 - Rev. 15/04 2-5
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Project engineering - Deployment TD-Wizard

Overview

Create project

TD-Wizard is a project engineering tool for the operating device TD 03
from VIPA. The TD-Wizard allows you to create a data block that contains
all parameters and messages for the TD 03.

You may import the data block in the SIMATIC Manager from Siemens into
your project and load it to the CPU. After the link-up of the TD 03 with valid
MPI parameters, the according DB contents are transferred from the CPU
to the TD 03.

Start the TD-Wizard via double click on LESEESSEERZE.

Type a file name for your STL-file and choose a storage directory or search
for an already existing STL-file!

Choose a data block number in Data Block ID.

ETDWizard. Yersion 1.1 X x|
E The wizard helps you to configure TD messages quickly and easily. when

i § completed the wizard generates the &AWL file for impart in your project

-
H 2 Diestination file ICi\NN-*'-\\""'L = |

z
Data Block D |12 -
¥ L =
Ta begin configuring TD messages, click Mext.
TD Wizard
et Cancel

Confirm your settings with C Nexts |

2-6
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Language and The TD 03 can monitor menu options and entry requests in a configurable

character set language and the according character set. The here chosen language has
no influence on the text of the user defined message texts that are
displayed by the TD 03.

Languages At the moment, the following languages are available:
* English
» German
O M
E The TD' menus and prompts are avallable in different national languages.
i i Which tppe of TD would you like to configure?
“r
z & TD0Z2 € TD200 from Siemerrs
" Select the language pou like the TD to suppart:
15
TD Wizard

< Back Mext Cancel

Confirm your settings with C Nexts |

HB116D - TD 03 - Rev. 15/04 2-7
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Release
additional menu
options

Menu option
Time of Day

Menu option
Force variables

Password
protection

The project engineering allows you to add further menu options in the

TD 03.

The following menu options can be activated:

* Set date and time
* Force variables in the CPU
» Activate password protection

ETDWizard. Yersion 1.1

i i Do vou like to enable the Time of Day menu?
Al [ * “es " Mo
g z
& The TD allows you to force 140 in the PLC.
Da you like ta enable the force menu?
E * Tes Mo
and the "Force menu'
Do you like to enable the password protection?
TD Wizard
* fes  No

The TD supparts a Time of Diay menu for setting the time of day clock in the PLC.

The TD supports a 4-digit password protection ta pratect the "Time of day menu™

Paszword (0000 - 9339) (0000

< Back Mext

Cancel

Here you may set the date and the time of day in your CPU using the

TD 03.

If you activate this menu option you may force selected in- res. outputs via
the TD 03, i.e. freeze them at a defined state. Forcing takes place at the
beginning and at the end of a cycle. During the cycle, forcing is

deactivated.

If you activate the password protection, you have additionally to define a
password with four characters length in the according field. This password
is stored in the parameter block of the TD 03 and protects the alteration of
variables that are embedded into one message.

Additionally, the access to the menu mode is password protected.

2-8
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Function keys and
refreshing rate

The TD 03 is provided with 8 function keys (F1 to F4 and SHIFT F1 to
SHIFT F4) that allow you access to the bit memory area in the CPU. As
soon as you push a function key, the according bit is set in the bit memory
byte. Define the wanted bit memory byte in the shown dialog window. The
according reaction to an alteration in this bit memory area has to be
programmed in the user application.

The dialog window allows you to set the refreshing rate for your TD 03.

The refreshing rate defines, how often the TD 03 calls the CPU with a
message request.

The setting of bit memory bytes with function keys is not influenced.

ETDWizard. Yersion 1.1 x|
E The TD zupparts 8 function keps (F1 through F4 and SHIFT F1 through SHIFT F4)
g i to manipulate memory bits in the PLC. Eight bits of memory in Bit Memorny Area in the
=1 PLC must be reserved for the TD to get them when a function key is prested
The carresponding memary bit is set, each time the function key is pressed.
z
& Which byte in the Bit Memary Area pou would ke to reserve for the TD?
=
The TD polls the PLC periodically for messages to display. Pleaze select an
update intervall, in which vou would like the messages to be updated:
TD Wizard Az fast as possible j

< Back Mext Cancal

During operation the behavior of the function keys may be selected within
the Menu mode by Termi nal Setup > F-keys node:

Normal: The corresponding flag of the CPU is set by pressing a function
key. It may only be reset by the user program.

Auto:  The corresponding flag of the CPU is set as long as the function
key is pressed.

Attention!

You must always assign a bit memory byte for the function keys of the
TD 03. Per default, the bit memory byte MB 0 is used. Please take also
care for this in your user application.

Always reserve a bit memory byte for your TD 03, although your
application doesn't use function keys!

HB116D - TD 03 - Rev. 15/04 2-9
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Size and number
of messages

With the TD 03 you may display messages in one (20 characters) res. in
two rows (40 characters). You may display up to two "one-row-messages"
simultaneously.

A 20-character-message uses 20Byte in the data block of the CPU. Every
message is shown in one row of the TD 03. That allows to display two
messages at one time.

A 40-character-message uses 40Byte in the data block. Only one message
can be displayed at a time.

#1410 200 Configuration wizard. Yersion 1.1 ] x|

The TD 200 dllows two messages sizes, please select the desired message

i B
4 > 3 :
" 20 character message mode - displays bwo messages at a time
2 &+ 40 character message mode - displays one messages at a time
2
i E The TD 200 allows you to configure up to 80 mezzages. How many
H c messages do pou wish to configure?
a _| Message(s)
TD Wizard

< Back IMext Cancal Help |

Set the standard size and the number of your messages. You may create
up to 80 messages.

2-10
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Addresses for
parameter block,
release flag and
messages

Parameter block

"Enable flags"
for messages

Messages

The following dialog window allows you to set the start addresses for the
parameter bytes, the bytes for the message release and for the message
texts.

M
E ‘r'ou have to define the offset inside the data block DB12, where the 10 byte
M i parameter definition will be lozated. Usuallp it is placed at offsst 0 [DBEO).
- Al B Starting byte for 10 byte parameter block. IE _|j
= ‘rou have configured 4 message(s| requiing 1 byte(s) for message enable flags.
‘r'ou have to define the offset in the data block, where the message enable flags will be

n e e

lonc:ated.

x Starting byte for enable flags I1 2 _Ij

‘rou have configured 4 message(s| requiing 160 byte(s) for the message definitions.
‘You have to define the offset in the data block,. where the messsage definitions will be

lo:ated.
Starting byte for message information |32 _Ij

TD Wizard

< Back I Mext » I Cancel

Set the start address from where on the parameter block with the size
10Byte will be stored in the DB. Per default the setting DBB 0 is used.

To display a message on your TD 03, your user application has to set an
according release bit in your DB.

Here you define the start address from where on the release bytes are
stored in your DB (default value:12).

Set the start address the messages are stored in sequence. The default
value is 32. The required number of bytes depends on the number of
required characters and on the number of messages that you've set in the
previous window. Every character used one byte. A message with 20
characters requires 20Byte in the data block, a message with 40
characters requires 40Byte.
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Create messages

Include
process data

This dialog window allows you to enter the text for the messages. The
content of the window depends on the number of characters that you've set
as standard size (20 or 40 characters).

The window also shows you the DB start address of the message and the
concerning message activation bit.

Erowzara verson 13— x
E ‘r'ou have configured 4 message(s). Please define the messages. starting with the
i i highest priority message first.
| | - Message 1 of 4
z
¢ MrETERAPEEPTTTTTTITIT
[
: [rrrrrerrrrrrrrrrrrnr
Message beginming addiess  DBB32
M bled bit  [DBX1Z7
TD Wizard - es3age enabled bi
Embedded data... | ¢ Frevious message | Mext message > |
< Back Finish Cancel |

During the text entry you may switch between the insert and the overwrite
mode by means of the PC key "Einfg/Ins".

The recent mode (INS res. OVR) is shown in the dialog window.

via IS ‘you may enter the next message.

For the inclusion of process data into a message, set the cursor at the

according position in the message and click on _ Embedded data.. LA dialog
window appears where you enter the data format of the process data and
get information about the storage path.

Embedded Data i x|
Data format———————— - Displap format——————— " Digits to the right of the
" None % Signed decimal
" word " Unsigned I =|
& Double Word " Real [Floating Paint)

v User must aknowledge message
¥ Uszeriz allowed ta edit this data

V' Should the ‘uzer edit of data’ be password protected?

s fan (el Edit Notifisation Bit  [DEx44.2
pooo Address of DataValue  [DED4E
Delete | (u] I Cancel |

Please regard that the monitoring of a process time-of-day requires that
the displayed addresses in the data block must be served by the user
program.

2-12
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Data format

Display format

Digits to the right of
the decimal

User must
acknowledge
message

User is allowed to
edit this data

Password
protection

So that the data value may be displayed, place for the data value and the
associated format should be reserved within the message.

Start anchor for the data value is the most right character of the value.
They are arranged right-justified to the point of anchor.

More characters are sorted left of the anchor. If the data value has more
characters than free space is available, it may overwrite the message texts.
Please take care to leave enough free positions for the data value!

The selection of the data format defines the size of the data value that is

embedded into the message.

» Select "none", if the message must be acknowledged but no process
time-of-day is displayed.

» Select "Word", if the data value is a word or an integer. This uses 2
characters in your message.

e Choose "Double Word", if the data value is a double word or a real
number. This uses 4 characters in your message.

Display the data value in the message as signed, unsigned or as real
number with decimals (Real).

By choosing the positions right of the decimal sign, value of an integer can
be scaled for the display. At a real number, you define the number of digits
right of the decimal. The real number is rounded to the given digits.

This control button defines if the message must be acknowledge by the

user. This causes that the message is shown until the operator pushes .

After the acknowledgement of the message, the acknowledgement bit is
set in the CPU and the enable bit for this message is reset. If you want a
message to be acknowledged, this is only possible by including a data
value without format at any position.

The activation of this control button allows the user to edit the according
data value.

As soon as you alter a data value in the TD, the "edit notification bit" is set.
By processing the bit in your user application, you may react to an entry.

If you've activated the password protection in one of the previous windows,
you may protect the data value for alterations by using your password.
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Structure of the The format word precedes the embedded data value and occupies 2
Format-Word positions (Byte) in the DB:
Byte Bit7 ...Bit0
0 Bit 0: (A) Acknowledgement

0 - No acknowledgement

1 - Acknowledgement required
Bit 1: (AN) Acknowledgement message

0 - No acknowledgement

1 - Message was acknowledged
Bit 2: (EN) Alteration message

0 - No alteration

1 - Message altered
Bit 3: (P) Password protection

0 - Password protection deactivated

1 - Password protection activated
Bit 4: (E) Alteration enabled

0 - Alteration not allowed

1 - Alteration allowed

Bit7..5:0
1 Bit 2 ... 0: (D) Position of the decimal sign
0 - No decimal sign
1 - one digit right of the decimal sign
2 to 7 - two to seven digits right of the decimal sign
Bit3: 0

Bit 6 ... 4: (S) Data size / Format
0 - no data value
1 - word value signed
2 - double word value signed
3 - word value unsigned
4 - double word value unsigned
5 - Real number value
6 - Reserved
7 - Reserved
Bit7: 0

Close entry and Finish | stores your project at the preset location as STL-file and closes
create DB TD-Wizard.

Transfer STL Import with following proceeding your STL file into your project:
into the project  Start the Siemens SIMATIC manager with your project.

» Select the folder "Sources" in the user program and select Insert >
External Source.

* Navigate to the STL file and compile this with Edit > Compile. The
corresponding DB may now be found in the folder "Blocks".

» Transfer the DB to your CPU. More about the transfer methods may be
found in the manual of your CPU.
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Commissioning

Preconditions » CPU system is built

* The corresponding DB has been created by the TD-Wizard, imported to
the project and transferred to the CPU.

Connection The connection to your CPU takes place using the delivered MPI cable
670-0KB0O via the MP?l jack. Here the panel may not be supplied
additionally externally.

As soon as the power supply of the CPU is switched on, the TD 03 is
supplied with DC 24V via MPI and starts automatically.

Power supply only Only if you use a MPI cable without power allocation instead of the

at usage of a third- delivered MPI cable 670-0KB0O0, the TD 03 may externally be supplied with

party cable DC 24V (20.4 ... 28.8V) using this addition power supply slot. The power
supply is protected against inverse polarity and overcurrent.

The simultaneous usage of external power supply and the delivered
MPI cable 670-0KB0O0 is not allowed and damages the TD 03!

For the connection of an external power supply, the sticker with the safety
information is to be removed before.

The wiring takes place with spring clamp technology.

The cabling with spring clamp technique enables a fast and easy
connection of your supply wires. In opposite to a screw connection, this
connection is vibration secure.

You may connect cables with a cross-section of 0.08 mm? to 2.5 mm?®. You
may use flexible cores without end case as well as stiff wires.

The wires are fixed at the spring clamp contacts as follows:

+O [ |+

| Al ML IM__ for screwdriver
MMM DC24V

for wires

The illustration on the left side shows the steps of the cabling seen from

top.
@ p

e To conduct a wire you plug a fitting screwdriver obliquely into the
rectangular opening like shown in the picture.

» To open the contact spring you have to push the screwdriver in the

l opposite direction and hold it.
» Insert the de-isolated wire into the round opening. You may use wires
M with a cross-section from 0.08mm? to 2.5mm?®.
» By removing the screwdriver the wire is connected safely with the plug
Ll connector via a spring.
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Proceeding of
commissioning

The TD 03 may be started again with
After restart the TD 03 works with its new parameter.

Switch on the power supply of your CPU.

Transfer your project including the DB to your CPU. More about the
transfer methods may be found in the manual of your CPU.

Connect the CPU und the TD 03 via MPI interface by the delivered cable
670-0KB00. As soon as the TD 03 is connected to the CPU, it is
automatically started up.

To serve the TD 03 with the contents of the DB valid communication
parameters like MPI address, baud rate, DB no. and so on are to be set
in the Menu mode.

By pushing the key ESC in the Display mode, you reach the Menu mode.

Navigate at Menu mode with v to the entry Term nal Set up and

confirm with Em.

Set with v respectively A

ENTER,

the following parameters and confirm with

- Term nal Address: wished MPI-Adresse for the TD 03
- CPU Address: MPI address of the connected CPU

- Paraneter Bl ock: DB number in the CPU created by the TD-
Wizard. So more DBs may be stored in the CPU.

- Baudrat e: Baud rate of the MPI net
- Highest Station: highest MPI address of your system

B8 after the settings are completed.

2-16
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Operating the TD 03 - Overview

Turn on

Operating modes

Display mode

Menu mode

Operation via
keyboard

Usage of the
function keys

The TD 03 should be connected to the CPU with the delivered cable (order
no.: 670-0KB00). As soon as the power supply of the CPU is switched on,
the TD 03 is provided via MPI by DC 24V and starts automatically.

The TD 03 has the following operating modes:
» Display mode
* Menu mode

After start, the TD 03 is in display mode. The display mode is the standard
operating mode of the TD 03. Here you may switch between the activated
messages respectively acknowledge them and alter process values.

with E5€

you can switch between display mode and menu mode.
Note!

So that incoming messages can be updated, the TD 03 must be switched
to display mode.

With display mode the cursor is invisible.

It appears by pushing A res. V_

To navigate through the menu, the following keys are available:

A res. v jumps to the previous res. next menu entry. - opens the

according menu entry. If this menu entry is a variable, you reach the

changing mode with B This is shown by the blinking of the variable.

You can jump to the individual decimal position with + A res. +

v , change the value with A and v and confirm with | or reset the

value to zero with + . respectively cancel with ESC.

Pushing one of the function keys N , a bit is set into a bit memory
byte in your CPU. By requesting the bit memory byte in your PLC program,
you are able to react to the entry.

By evaluating the bit memory byte within the PLC program, it may be
reacted to an input.

The behavior of the function keys may be selected by the parameter
F- keys node within the Menu mode.

Push additionally to a function key to call F5 ... F8.
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Operating the TD 03 - Menu mode

Start

Operating via
keyboard

Functions

Display
messages

Pushing E=¢ at the TD 03 in the display mode switches to the menu mode.
So far as there is no DB in the CPU concerning the TD 03 the menu is
displayed in English.

Note!

So that incoming messages can be updated, the TD 03 must be switched
to display mode.

For navigation use the following keys:

A res. v jumps to the previous res. next menu option. Activate the

according menu option with . If the menu item is a variable, brings
you into the alteration mode. This is shown with a blinking of the variable.
Now you may alter the value with A and v and confirm with or

interrupt with ESC.

In the menu mode, the following options are available:
* View messages

* View CPU Status

* Terminal Setup

If activated in the TD-Wizard, the following menu options are also
available:

* Set Date and Time
e Force l/O

This function allows you access to all defined messages.

Choose the option Vi ew Messages and push . Flip between the

messages with = res. V_

2-18
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View CPU Status

Terminal SETUP

This function shows you the recent operating state (RUN/STOP) of your
CPU.

Call the entry Vi ew CPU St at us and push 2 The TD 03 now displays
the recent operating state of your CPU.

=29 switches back to the display mode.

The SETUP allows you to enter parameters into the TD 03 like
communication parameter (MPl addresses, baud rate, etc.), DB no.,
functionality of the function keys and contrast of the display.

Navigate to the option Ter m nal Set up and push .
Enter the wanted MPI address into Ter mi nal Addr. Select the option,

A

push , set the value with v res. and confirm with .

v

Use to reach CPU Addr ess and set the MPI address of your CPU.

For the TD 03 receives its data from a CPU data block, you may store
several data blocks in the CPU. Via the entry "Parameter Block" you define
the wanted DB via its number.

Navigate on with v until you reach Baudr at e, set the baud rate of your
MPI network and at the entry Hi ghest St ati on the highest MPI address
in your system.

The behavior of the function keys may be selected within the F- keys
node. Here are the following possibilities:

Normal: The corresponding flag of the CPU is set by pressing a function
key. It may only be reset by the user program.

Auto:  The corresponding flag of the CPU is set as long as the function
key is pressed.

As last option Cont r ast, you may alter the contrast of the TD 03.

=29 always allows you to switch back into the display mode. After the mode
change, the TD 03 reboots.

Now the TD 03 is ready to receive data from your CPU via MPI.
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Set Date/
Time-of-Day
(activateable)

Force I/Os
(activateable)

This menu option must be activated via the TD-Wizard. Select the option

Set Date/ Ti me and push 5 Date and time-of-day are displayed.

Now you may navigate to the wanted value via and alter it via A res.

v . After reaching the value for seconds, push B {0 transfer the values
to the CPU. The TD 03 switches back to display mode.

Note!

The TD 03 does not proof the correctness of date and time. You may also
enter invalid dates into the CPU.

This menu option is only available if enabled in the TD-Wizard. You may
also protect this function with a password. For ce |/ Oallows you to set in-
res. outputs to a fixed value. During the cycle, the values may be
overwritten by your user application. As soon as forcing is active, this is
shown via a Force-LED at the CPU front.

Choose the entry For ce |/ Oand push .

Now you can force variables with For ce Vars and deactivate the force
state with "Unforce All 1/0O".

Select For ce Var s and push until the cursor is on Not f or ced.

Now the following variable types are available that can be chosen via

Type Variable = Value
OD/ID (Double word) 0 = 00000000
OW/IW (Word) 0=0

OB/IB (Byte) 0=0

O/l (Bit) 0.0=0

navigates from Type to Variable and on to Value and = res. v

cause changes. Another B closes the entry.
If Force is active, the CPU shows this via the Force-LED.
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Lock via
password

Danger!

Due to the fact that the force function influences defined in-/outputs, which
could cause unexpected reactions in your automation system, you should
only use this function for test purposes!

The TD 03 allows you to lock the menu mode and the value setting via a
password. The password is entered in the TD-Wizard. You activate the
password request at value entering during the project engineering of your

messages by opening the according dialog via _ Embedded data.. ‘

If you've activated the password protection in the TD-Wizard, the menu
mode is locked via your password. Every time the menu mode is requested

via =29 or if activated every time at value entry, a password request takes

place. Jump with B between the numbers and with v res. = to the

wanted character. After the acknowledgement of your password with :
you can edit messages and values without password request until you turn
off the power supply or until you select the menu option Lock Password

ENTER
and push .
The TD 03 activates your password and switches back to display mode.
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Firmware update

Overview

Read firmware
version

Proceeding

The TD 03 allows you to update the firmware via an update software and
the Green Cable from VIPA.

The last recent firmware versions can be downloaded in the service area of
Www.vipa.com.

Attention!

Please be very careful with loading a new firmware. Under certain
circumstances you may destroy the TD 03, for example if the voltage
supply is interrupted during transfer or if the firmware file is defective.

In this case, please call the VIPA hotline!

Please also regard that the update version has to be different from the
existing version, otherwise no update will happen.

If you didn't execute a firmware update before, you may find the recent
firmware version on the label on the backside of the TD 03.

To download the firmware file, order no. and version no. (HW) are
required. These ID numbers mark the storage directory of the concerning
firmware. For example: The firmware file of a TD 03 with the order no.
603-1TD00 and HW no. 1 is stored under the file name 603-1td00_al.xxx
(xxx is the according firmware version).

e Go to www.vipa.com.

» Click at Service / Support > Downloads > Firmware and navigate via
"HMI" to the firmware for your TD.

» Extract the zip-file into the wanted directory on your PC.

e If you want to execute the update with the Green Cable, the VIPA
"Updater” is required that you may download under "Firmware" in the
download area. Start the "Updater" with cpu_up.exe.
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Firmware update
via Green Cable
and cpu_up.exe

& Updater  v1.07

0. Flug I the Download-wire

1. Select a zerial Interface

+ COM1 (" COM3
" COM2 COM4

zetup |

2. reset Device by power up

El corinect

4, are you <connected: now?
if ot repeat step 2. and 3.

5. venfy Hardware

wernify hardiare |

E. update the Device

downimad |

7. power down the Device
and unplug the Download-\Wire

to 0.

to 1.
to 2.

to 3.
to 4.

to 5.

to 6.

to 7.

Connect the COM interface of the PC and the MP? jack of your
TD 03 via the Green Cable.

Type the COM interface (you should not alter the setup)

Turn off the power supply of your TD 03, push the
turn on the power supply again.

Now the TD 03 is ready for the firmware update. Nothing is shown
on the display.

Click on lin the updater.

A connection to the TD 03 is established and shown via the
message [connected].

If an error message appears instead, repeat the steps above with
another COM interface.

key and

cohnect

|. Your TD 03 is

At error free connection click on weify hardware

now prepared for data transfer.

download

A click on | opens a file selection window. Choose

the according firmware and start the download with - 2en

If the error message "The selected file doesn't fit to your
hardware" appears you may have been tried to download a
firmware that is not compatible to your TD 03. With a valid
firmware version, the update process starts. This process may last
several minutes and is shown in a process bar.

After the download, the following window should appear:
O[]

& Updater ¥1.07
0. Plug In the Download-wire

<sector 12 programmed: -
=gector 13 programmed:=

<sector 14 programmed:=

<sector 15 programmed:

<gector 16 programmed=>

=sector 18 programmed:=

<dones=

1. Select a serial Interface

LG S N
& B2 T CHRA

SEL I

2. reset Device by power up

3 Gofiieet

4. are you <connecteds now?

if not, repeat step 2. and 3. Green Cable

Carrect Wrang |

8. verify Hardware

ey RardwarE I
E. update the Device

doyrlad I

F. power down the Device

always — 4
cress the
baards |

hold down
while 1
Power ON

and unplug the Download-Wie

Turn off the power supply of your TD 03, disconnect the Green
Cable, connect the TD with the CPU and turn on the power supply
again. Now the TD 03 is ready with the new firmware.

After the firmware update the contrast of the display could be out of tune.
In this case you have to adjust the contrast in the menu modus again.

If your TD 03 does not start anymore, an error occurred during the
firmware update. Please call in this case the VIPA hotline.

HB116D - TD 03 - Rev. 15/04
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Chapter 3 Installation Guidelines

Chapter 3

Overview

Content

Installation Guidelines

The chapter gives you information about the interference-free installation of
Programmable Logic Controls (PLC) together with a TD 03.
Here we describe possible paths how interference can enter the controller,

how you ensure the electromagnetic compatibility (EMC) and how to
approach shielding and screening issues.

Topic Page
Chapter 3 Installation Guidelines..............uuuviiiiiiiiiiiiiiiiiiis 3-1
Basic rules for the EMC-equitable assembly of installations................. 3-2
EMC-equitable assembly...........coooiiiiiiiii e 3-6
EMC-equitable cabling ........ooooeiieiii e 3-7
Special precautions providing high noise immunity ...............ccccvvveen. 3-11
Checklist for the EMC-compliant installation of controllers ................. 3-12
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Basic rules for the EMC-equitable assembly of installations

What is EMC?

Possible sources
for disturbances

The term electromagnetic compatibility (EMC) refers to the ability of an
electrical device to operate properly in an electromagnetic environment
without interference from the environment or without the device causing
illegal interference to the environment.

The Operation Panels are developed for applications in harsh industrial
environments and complies with EMC requirements to a large degree. In
spite of this you should implement an EMC strategy before installing any
components, which should include any possible source of interference.

Electromagnetic interference can enter your system in many different ways:

Fields

=

Automation .
< Bus > System < I/O-Signal >
T @

Power PE

Interference is coupled into your system in different ways, depending in the
propagation medium (conducted or not conducted) and the distance to the
interference source.

We differentiate between:

» galvanic coupling

e capacitate coupling

* inductive coupling

» radiated power coupling

3-2
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Coupling
mechanisms and
interference
sources

The following table shows the four different coupling mechanisms, their
causes and possible interference sources.

Coupling mechanism

Cause

Typical source

Galvanic coupling

Disruptor
galvanic
coupling line

Automation
System

Galvanic or metallic coupling
always occurs, when two
current circuits have a
common line.

Pulsed devices

(Net influence from
transducers and foreign net
devices)

Starting motors

Different potential of
component cubicles with
common current supply

Static discharges

Capacitate coupling

Disruptor
capacmve
coupllng line

Automation
System

Capacitate or electric coupling
occurs between conductors
with different potential.

The coupling is proportionate
to the temporal change of the
voltage.

Interference through parallel
signal lines

Static discharge of the
personnel

Contactors

Inductlve coupllng

@ Disruptor

inductive
<—— coupling

line

| «

wanted signal

Automation
System

Inductive or magnetic coupling
occurs between two current
active line loops.

The magnetic flows associated
with the currents induct
interference voltages.

The coupling is proportional to
the time related change of the
current.

Transducers, motors,
electric welding devices

Parallel net cables
Cables with toggled currents

Signal cable with high
frequency

Unused coils

Radiate power coupling

Disruptor

¢ radiated

coupling
line

Automation
System

One talks of radiate power
coupling, when an electro-
magnetic wave meets a line
circuit.

The hit of the wave inducts
currents and voltages.

Sender in the neighborhood
(e.g. walkie-talkie)

Sparking lines

(sparking plugs, collector of
electric motors, welding
devices)

HB116E - TP - Rev. 15/04
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Basic rules for
ensuring EMC

In many cases, the adherence to some very elementary rules is sufficient
to ensure EMC. For this reason we wish to advise you to heed the following
rules:

During the installation of your automation units you should ensure
that any inactive metal components are grounded via a proper large-
surface earth!

» Interconnect any inactive metal components via low-impedance
conductors with a large cross-sectional area.

» Execute screw connections at coated and anodized metal parts either
with special contact washer or remove the isolating protective film.

e Install a central connection between the chassis ground and the
earthing/protection system.

Ensure that cabling is routed properly during installation!

» Divide the cabling into different cable groups
(High voltage lines, power supply lines, signal lines, data lines).

* Always install high voltage lines and signal or data lines in separate
channels or bundles.

» Install signal and data lines as close as possible to any metallic ground
surfaces (e.g. frames, metal rails, sheet metal).

Ensure that the screening of lines is grounded properly!

« Data lines must be screened. The screen has to be laid both-sided.

* Analog lines must be screened. Where low-amplitude signals are
transferred it may be advisable to connect the screen on one side of the
cable only.

» Attach the screening of cables to the ground rail by means of large-
surface connectors located as close as possible to the point of entry. Fix
the cables mechanically by means of cable clamps. Route the
connected screen to the modules without interruptions, but don't
connect the screen again.

* Ensure that the ground rail has a low-impedance connection to the
cabinet/cubicle.

» Use only metallic or metallic covers for the plugs of screened data lines.

34
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In critical cases you should implement special EMC measures!

« Connect snubber networks to all inductive loads that are not controlled
by special EMC modules.

* Use incandescent lamps for illumination purposes inside cabinets or
cubicles, do not use of fluorescent lamps.

Create a single reference potential and ensure that all electrical
equipment is grounded wherever possible!

* Ensure that grounding measures are implemented effectively. The
controllers are earthend to provide protection and for functional reasons.

* Provide a star-shaped connection between the plant, cabinets/cubicles
and the grounding/ protection system. In this way you can avoid ground
loops.

* Where potential differences exist, you must install sufficiently large
equipotent bonding conductors between the different parts of the plant.
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EMC-equitable assembly

Guidelines for
assembling and
grounding of
inactive metal
parts

Mostly, measures for suppressing interference voltages are only taken,
when the control is already in commission and the perfect receive of a
wanted signal is disturbed.

Causes for such interference's are in the most cases inadequate reference
potentials, coming from mistakes at the device assembly and installation.

When assembling the devices, you have to ensure the large-surface
grounding of the inactive metal parts. A correctly done grounding supports
an unambiguous reference potential for the control and reduces the impact
of coupled interferences.

Grounding means the conducting connection of all inactive metal parts.
The sum of all interconnected inactive parts is called ground.

Inactive parts are all conductive parts electrically separated from all active
parts by means of a basic isolation and that may only get voltage in case of
an error.

The ground must not adopt dangerous contact voltage even in case of an
error. Thus you have to connect the ground with the protected earth
conductor. To avoid ground loops, local distant ground constructions
(cubicles, construction and machine parts) have to be connected with the
protected earth conductor system in star-topology.

Please regard at grounding:
» Connect the inactive metal parts as carefully as the active ones.

» Take care of impedance-low metal-metal-connections, e.g. with large-
surface and well conductive contacts.

* If you include coated or anodized metal parts in the grounding, you have
to come through the isolating protection layers. For this you may use
special contact washers or remove the isolation layer.

» Protect the connection points from corrosion, e.g. with grease.

* Moveable grounding parts (e.g. cubicle doors) have to be connected via
flexible ground strips. The ground strips should be short and have a
large surface, because the surface is decisive for the diversion of high
frequency interferences.
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EMC-equitable cabling

Line routing

Line routing inside
and outside of
cubicles

Content of this section is the line routing of bus, signal and supply lines.
Object of the line routing is to suppress the "slurring” at parallel lines.

For an EMC-equitable routing of the lines it is convenient to divide the
cables in different groups and install each group itself:

Group A

» screened bus and data lines

» screened analog lines

» unshielded lines for direct voltage < 60V

» unshielded lines for alternating voltage < 25V
» Coaxial cables for monitors

Group B
» unshielded lines for direct voltage >60V and <400V
» unshielded lines for alternating voltage >25V and <400V

Group C
» unshielded lines for direct and alternating voltage >400V

Group D
» Lines for H1 respectively TCP/IP
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Combination of
groups

Line routing
outside of
buildings

Lightning
protection

Following the table you may see the conditions for the cabling of the line

groups by combining the single groups:

Group A

Group B

Group C

Group D

Group A

[1]

[2]

[3]

[4]

Group B

[2]

[1]

[3]

[4]

Group C

[3]

[3]

[1]

[4]

Group D

[4]

[4]

[4]

[1]

[1] | The lines may be installed in common bundles or cable trusses.

[2] |The lines have to be installed in different bundles or cable trusses
(without min. distance).

[3] |The lines have to be installed in different bundles or cable trusses
inside of cubicles and outside of the cubicle but inside the building
in separated cable trusses with a min. distance of 10cm.

[4] | The lines have to be installed in different bundles or cable trusses
with a min. distance of 50cm.

Wherever possible, exterior cabling should be installed on metallic cable
trays. A galvanic connection must be provided for joints between cable
trays.

You must abide by the applicable lightning protection and grounding
regulations when installing exterior cables.

Attention!

Where cables and signal lines for PLC equipment are installed outside of
buildings, the conditions for internal and external lightning protection must
be satisfied.

» Exterior lines should either be installed in metallic conduit pipes that is
grounded on both ends or in steel-reinforced concrete cable trunks with
continuously connected reinforcing.

» Signal lines should be protected against overvoltage by varistors or by
lightning arrester filled with rare gas.

» Install these protective elements at the location where the cables enter
the building.

Note!

Any lightning protection system must be based on an individual
assessment of the entire plant. For questions please contact VIPA GmbH.

3-8

HB116E - TP - Rev. 15/04




Manual VIPA HMI

Chapter 3 Installation Guidelines

Equipotential
bonding

Rules for
equipotential
bonding

Screening of lines
and cables

Potential differences can occur between different sections when controllers
and peripheral equipment are connected by means of non-isolated
connections or the screens of screened cables are connected at both ends
and grounded on different sections of the plant.

One reason for a potential difference can be that different sections of the
plant are powered from different power sources. These potential
differences must be reduced by means of equipotential bonding conductors
to ensure that the electronic equipment employed on the plant operates

properly.

» The lower the impedance of the equipotential bonding conductor, the
higher the effectiveness of potential equalization.

* The impedance of the equipotential bonding conductor must not exceed
10% of the impedance of the screen where screened signal lines are
connected between the different sections of the plant and the screening
is connected to ground/neutral on both sides.

» The cross-sectional area of the equipotential bonding conductor must be
calculated to carry the maximum equalization current. The following
cross-sections have been successfully employed:

- 16mm? Cu for equipotential bonding conductors up to 200m
- 25mm? Cu for equipotential bonding conductors exceeding 200m.

» Use copper or galvanized steel for equipotential bonding conductors.
These must be connected to ground/neutral by means of large-surface
connections that are protected from corrosion.

» The equipotential bonding conductor should be installed in such a
manner that it includes the smallest surface between the bonding
conductor and the signal lines.

Screening is one method commonly used to reduce (attenuate) the
interference pick-up from magnetic, electrical or electromagnetic fields.

» Interference on screens is conducted to ground by the conductive
connection between the screen and the screening rain/enclosure. To
avoid interference from these currents it is very important that the
neutral connection is a low-impedance connection.

» You should only use cables that are provided with a braided screen. The
degree of screening should be more than 80%.

» Avoid cables with foil-type screens as the foil can be easily damaged by
tension and pressure at the point of attachment; this can result in
reduced effectiveness of the screening action.

» As a rule you should always ground the screens of cables on both ends.
This is the only way in which you can ensure that high frequency
interference is attenuated properly.
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One-sided
grounding of
screens

Connecting the
screen

In exceptional cases it may be necessary to ground the screen on one side
only. However, this will only attenuate the lowest frequencies. The one-
sided grounding of screens may provide advantages when:

* Itis not possible to install an equipotential bonding conductor
* Analogue signals (a few mV or pA) must be transmitted
» Foil-type screening (static screening) is employed.

You should always use metallic or metalized covers for serial data lines.
Connect the screen of the data line to the cover. Do not connect the
screen to PIN 1 of the connector!

In case of stationary operations it is recommended that the remove the
insulation from the screened cable without cutting the screen and to attach
this point to the screening/neutral rail.

Note!

Potential differences can give rise to an equalization current via the screen
connected between the two ground connections.

In this case you must install an additional equipotential bonding conductor.

Please observe the following points when you handle the screens:

* Use only metallic cable clamps when connecting the screening of
cables. These clamps must provide a good electrical contact and a
large-surface connection to the screen.

» Attach the screens to the screening rail directly at the point where the
cables enter the enclosure.
The screening conductor must be continued to the module without
interruption, however, it must not be connected to the module!

i
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Special precautions providing high noise immunity

Inductors require
snubber networks

Equipotential
bonding

Power outlet for
PGs

Cubicle
illumination

Suppression of
fluorescent lamps
in cubicles

Inductors controlled by your programmable controller (e.g. contactors and
relays) do not normally require additional snubber networks or suppressors
as the respective modules have been provided with the required
components.

Snubber networks must only be connected to inductors when output
circuits can be disabled by means of additional contacts (e.g. relay
contacts). In this case the integrated suppressors on the module are also
disabled.

You can connect diodes to suppress back-emc, varistors or RC-networks
to the inductors.

Connections of Connections of
DC-activated inductors AC-activated inductors
using a diode using a Z-diode using a varistor using RC-network

] = A RVAN ] L]

— —

Every cubicle must be provided with a power outlet for the PU. These
outlets must be wired to the distribution system, which is also used to
connect the neutral conductor for the cubicle.

i S— Y S—

.

The cubicle illumination should consist of incandescent lights, e.g.
LINESTRA-lamps. Avoid using fluorescent lamps as these lamps can
cause interference.

If you can not avoid using fluorescent lamps you should implement the
steps outlined in the following figure.

O [1] Fluorescent lamp
oo — [2] Screen above the lamp
4
07 [3] Screened cable
5 [4] Switch with metallic cover
- [5] Line filter or screened power
cable
\_/\_/
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Checklist for the EMC-compliant installation of controllers

EMV-measures

Space for Notes

Connection of the inactive parts

You should take special care to check the connections of:
¢ Module racks

* Frames

« Screen and protected earth conductor

Are all the inactive metal parts interconnected by means of
large-surface and low-impedance connections?

Has a proper connection been installed with respect to the
ground/protected earth conductor system?

Has the isolation been removed from varnished and anodized
surfaces or have these connections been fitted with special
contact washer?

Have the connection been protected from corrosion, e.g. by
means of grease?

Have doors been grounded by means of grounding straps
connected to the body of the cubicle?

Cable routing

Cabling divided into groups?

Power cables (230 ... 400V) and signal lines installed in
separate channels or bunches?

Potential compensating

When installing the equipment at separate locations, check
the installation of the potential compensating line.

Cable screen

All covers of plugs are metallic?

All analog and data lines installed screened?

Line screens attached to the screening or the protected earth
conductor?

Have the screens been connected by means of large-surface
and low-impedance cable clamps?

Cable screens grounded both-sided where possible?

Inductors

Have the coils of contactors controlled by means of contacts
been connected to snubber networks?

3-12
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